
Digital Design with Adobe Illustrator: A 

Practical Guide

Introduction

Adobe Illustrator is a powerful vector graphics editor 

that  allows you to  create  stunning designs  for  print, 

web, and mobile. The Illustrator workspace is designed 

to be intuitive and efficient, with all the tools you need 

within easy reach.

In  this  chapter,  we'll  take  a  tour  of  the  Illustrator 

workspace  and  learn  how  to  navigate  the  different 

panels and menus. We'll also learn how to create and 

save  new  documents,  set  up  artboards  and  units  of 

measurement,  and  use  selection  tools  and  keyboard 

shortcuts.

Creating and Editing Vector Graphics
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Vector graphics are made up of mathematical curves 

and  shapes,  which  makes  them  infinitely  scalable 

without  losing  quality.  This  makes  them  ideal  for 

creating  logos,  icons,  illustrations,  and  other  design 

elements that need to be used at different sizes.

In  this  chapter,  we'll  learn  how  to  create  and  edit 

vector  graphics  using the Pen Tool  and Shape Tools. 

We'll  also  learn  how  to  apply  fills,  strokes,  and 

gradients, and how to align and distribute objects.

Text and Typography

Text  is  an  essential  part  of  many  designs,  and 

Illustrator  provides  powerful  tools  for  working  with 

text and typography. In this chapter, we'll learn how to 

create and format text, work with fonts and character 

styles, and align and justify text. We'll also learn how to 

use  paragraph  styles  and  tabs,  and  how  to  create 

artistic text.

Color and Color Management
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Color is a powerful tool that can be used to create a 

variety of effects in your designs. Illustrator provides a 

wide  range  of  color  tools,  including  color  swatches, 

color gradients, and color blends. In this chapter, we'll 

learn  how  to  understand  color  models,  create  and 

apply color swatches, and adjust brightness,  contrast, 

and  saturation.  We'll  also  learn  how  to  use  color 

gradients  and  blends,  and  how  to  manage  color 

profiles.

Effects and Filters

Effects  and  filters  can  be  used  to  add  a  variety  of 

special  effects  to  your  designs.  Illustrator  provides  a 

wide range of effects and filters, including layer effects, 

image effects,  and warp effects.  In this chapter,  we'll 

learn how to apply layer effects, use filters to enhance 

images, and create drop shadows and inner shadows. 

We'll  also  learn how to  create  bevels  and embosses, 

and how to use the Warp Tool.

Working with Images
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Images are often used in designs to add realism and 

detail.  Illustrator  provides  a  variety  of  tools  for 

working with images, including tools for importing and 

placing  images,  adjusting  image  size  and  resolution, 

and  cropping  and  masking  images.  In  this  chapter, 

we'll  learn  how  to  import  and  place  images,  adjust 

image size and resolution, crop and mask images, apply 

image effects, and create image trace objects.

Advanced Drawing Techniques

Illustrator  provides  a  variety  of  advanced  drawing 

techniques  that  can  be  used  to  create  complex  and 

sophisticated designs. In this chapter, we'll learn how 

to  create  clipping  masks,  use  the  Pathfinder  Panel, 

work  with  patterns  and  symbols,  create  custom 

brushes, and draw perspective grids.

Page Layout and Typography

Page layout is the process of arranging text and images 

on a page to create a visually appealing and readable 
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document.  Illustrator  provides  a  variety  of  tools  for 

page layout, including tools for creating and managing 

pages, setting up master pages, using guides and rulers, 

and working with margins and bleeds. In this chapter, 

we'll  learn  how to  create  and  manage  pages,  set  up 

master  pages,  use  guides  and  rulers,  work  with 

margins and bleeds, and export for print and web.

Web Graphics and Animation

Illustrator is a powerful tool for creating web graphics 

and  animations.  In  this  chapter,  we'll  learn  how  to 

create web graphics for different screen sizes, optimize 

images  for  the  web,  use  CSS  and  JavaScript  for 

animation, and export for HTML5 and SVG. We'll also 

learn how to create interactive graphics.

Troubleshooting and Tips

Even the most  experienced Illustrator users  run into 

problems  from  time  to  time.  In  this  chapter,  we'll 

provide  tips  for  troubleshooting  common  Illustrator 
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errors, as well as time-saving tips and tricks. We'll also 

provide resources for further learning.
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Book Description

Digital  Design  with  Adobe  Illustrator:  A  Practical 

Guide is  the  ultimate guide to  Adobe Illustrator,  the 

industry-leading  vector  graphics  editor.  With  clear, 

step-by-step  instructions  and  helpful  examples,  this 

book will  teach you everything you need to know to 

create stunning designs for print, web, and mobile.

Whether you're a complete beginner or a seasoned pro, 

you'll find something in this book to help you take your 

Illustrator skills  to the next level.  From the basics of 

creating  and  editing  vector  graphics  to  advanced 

techniques  like  using  layer  effects  and  creating  web 

animations, this book covers it all.

In  addition  to  its  comprehensive  coverage  of 

Illustrator's  features and functionality,  this  book also 

includes valuable tips and tricks to help you work more 

efficiently and create better designs. You'll learn how to 

troubleshoot  common  problems,  optimize  your 
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workflow, and get the most out of Illustrator's powerful 

tools.

With its clear,  concise writing style and its wealth of 

practical  examples,  Digital  Design  with  Adobe 

Illustrator: A Practical Guide is the perfect resource 

for  anyone  who  wants  to  learn  Adobe  Illustrator. 

Whether you're a student, a professional designer, or 

simply  someone  who  wants  to  create  beautiful 

graphics, this book will help you achieve your goals.

In this book, you'll learn how to:

 Navigate the Illustrator workspace and use the 

essential tools

 Create  and  edit  vector  graphics  using  the  Pen 

Tool and Shape Tools

 Apply fills, strokes, and gradients to your designs

 Align and distribute  objects  to  create  balanced 

and visually appealing compositions
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 Work  with  text  and  typography  to  create 

beautiful and readable headlines, body copy, and 

logos

 Use  color  effectively  to  create  eye-catching 

designs that stand out from the crowd

 Apply  effects  and  filters  to  add  depth  and 

dimension to your designs

 Work with images to add realism and detail to 

your designs

 Create  web  graphics  and  animations  for  a 

variety of devices and platforms

 Troubleshoot  common  problems  and  optimize 

your workflow to work more efficiently

Digital  Design  with  Adobe  Illustrator:  A  Practical 

Guide is the essential guide to Adobe Illustrator. With 

its  clear,  step-by-step  instructions  and  helpful 

examples,  this  book  will  help  you  create  stunning 

designs for print, web, and mobile. 
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Chapter 1: Getting Started with Adobe 

Illustrator

Navigating the Illustrator Workspace

Adobe Illustrator is a powerful vector graphics editor 

that  allows you to  create  stunning designs  for  print, 

web, and mobile. The Illustrator workspace is designed 

to be intuitive and efficient, with all the tools you need 

within easy reach.

In  this  chapter,  we'll  take  a  tour  of  the  Illustrator 

workspace  and  learn  how  to  navigate  the  different 

panels and menus. We'll also learn how to create and 

save  new  documents,  set  up  artboards  and  units  of 

measurement,  and  use  selection  tools  and  keyboard 

shortcuts.

The Document Window

The document window is the main area where you'll 

work in Illustrator. It contains the artboard, which is 
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the area where you'll create your designs. The artboard 

can be resized and moved to fit your needs.

The Toolbar

The  toolbar  is  located  along  the  left  edge  of  the 

document window. It  contains a variety of  tools  that 

you can use to create and edit your designs. The tools 

are organized into categories, such as Selection, Shape, 

and Text.

The Control Panel

The  Control  Panel  is  located  below  the  toolbar.  It 

provides  options  for  the  currently  selected  tool.  For 

example, if you select the Rectangle Tool, the Control 

Panel  will  provide  options  for  the  rectangle's  size, 

shape, and fill color.

The Panels

The  panels  are  located  on  the  right  side  of  the 

document  window.  They  provide  additional 

information  and  options  for  working  in  Illustrator. 

11



Some of the most commonly used panels include the 

Layers  Panel,  the  Swatches  Panel,  and  the  Gradient 

Panel.

The Menu Bar

The menu bar  is  located at  the  top of  the  screen.  It 

contains a variety of menus that provide access to all of 

the features and functions in Illustrator.

Keyboard Shortcuts

Keyboard  shortcuts  can  be  used  to  speed  up  your 

workflow in Illustrator. There are keyboard shortcuts 

for almost every command in Illustrator. You can find a 

list of keyboard shortcuts in the Help menu.

Getting Started

To create a new document in Illustrator, click on the 

File menu and select New. In the New Document dialog 

box,  enter a name for your document and select  the 

desired  dimensions.  You can also  choose  to  create  a 

document based on a template.
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Once you have created a new document, you can start 

adding objects to the artboard. To create a new object, 

select a tool from the toolbar and click on the artboard. 

You can also use the keyboard shortcuts to create new 

objects.

To select an object, click on it with the Selection Tool. 

You  can  also  use  the  keyboard  shortcuts  to  select 

objects.

To move an object, click on it and drag it to the desired 

location.  You can also  use  the  keyboard shortcuts  to 

move objects.

To  resize  an  object,  click  on  it  and  drag  one  of  the 

handles.  You can also  use  the  keyboard shortcuts  to 

resize objects.

To rotate an object,  click on it  and drag the rotation 

handle.  You  can  also  use  the  keyboard  shortcuts  to 

rotate objects.
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To change the color of an object, select it and then click 

on the Fill Color swatch in the Control Panel. You can 

also use the keyboard shortcuts to change the color of 

objects.

To add text to an object, select the Type Tool and click 

on the artboard. You can then type your text. You can 

also use the keyboard shortcuts to add text to objects.

Conclusion

The Illustrator  workspace  is  designed to  be  intuitive 

and efficient,  with all  the tools you need within easy 

reach. By learning how to navigate the workspace, you 

can quickly and easily create stunning designs.
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Chapter 1: Getting Started with Adobe 

Illustrator

Creating and Saving New Documents

Creating a  new document  in  Adobe Illustrator  is  the 

first step to starting any new project. When you create 

a new document, you can specify the size, orientation, 

color mode, and other settings.

To create a new document, click on the "File" menu and 

select  "New".  The  New  Document  dialog  box  will 

appear. In the dialog box, you can specify the following 

settings:

 Name: The name of the new document.

 Preset: A  predefined  set  of  settings  for  the 

document.

 Width: The  width  of  the  document  in  inches, 

millimeters, or pixels.
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 Height: The  height  of  the  document  in  inches, 

millimeters, or pixels.

 Orientation: The  orientation  of  the  document 

(portrait or landscape).

 Color  Mode: The  color  mode of  the  document 

(RGB or CMYK).

 Raster Effects: The resolution of the document 

in pixels per inch (ppi).

 Artboards: The  number  of  artboards  in  the 

document.

Once  you  have  specified  the  settings  for  the  new 

document, click on the "OK" button. The new document 

will  be  created  and  will  appear  in  the  Illustrator 

workspace.

You  can  also  save  your  Illustrator  documents  in  a 

variety of file formats.  The most common file format 

for Illustrator documents is the AI file format. AI files 

can be opened and edited in Illustrator, and they can 
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also be exported to other file formats, such as EPS, PDF, 

and SVG.

To save a document in the AI file format, click on the 

"File" menu and select "Save". The Save As dialog box 

will appear. In the dialog box, navigate to the location 

where you want to save the file and enter a name for 

the  file.  Then,  select  the  "AI"  file  format  from  the 

"Format"  drop-down  menu  and  click  on  the  "Save" 

button.

You can also save your Illustrator documents in other 

file  formats,  such  as  EPS,  PDF,  and  SVG.  To  save  a 

document in a different file format, select the desired 

file format from the "Format" drop-down menu in the 

Save As dialog box.

It  is  important  to  save  your  Illustrator  documents 

frequently  to  avoid  losing  your  work.  You  can  save 

your  documents  manually  by  clicking  on  the  "File" 

menu and selecting "Save", or you can set Illustrator to 

save  your  documents  automatically  at  regular 
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intervals.  To  set  Illustrator  to  save  your  documents 

automatically,  click  on  the  "Preferences"  menu  and 

select "File Handling". In the File Handling preferences 

dialog  box,  select  the  "Save  Automatically  Every" 

checkbox and enter the desired interval (in minutes).

18



Chapter 1: Getting Started with Adobe 

Illustrator

Setting  Up  Artboards  and  Units  of 

Measurement

Artboards  are  the  foundation  of  any  Illustrator 

document. They define the size and orientation of your 

design,  and they can be used to  organize and group 

different elements of your artwork.

When you create a new Illustrator document, you can 

choose from a variety of preset artboard sizes or create 

your  own  custom  size.  You  can  also  choose  the 

orientation  of  your  artboard,  either  portrait  or 

landscape.

Once you have created an artboard, you can resize it or 

move it around the document window as needed. You 

can also add new artboards to your document at any 

time.
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In addition to artboards, Illustrator also allows you to 

set the units of measurement for your document. This 

is  important  for  ensuring  that  your  designs  are  the 

correct size and scale. Illustrator supports a variety of 

units  of  measurement,  including  inches,  centimeters, 

pixels, and points.

You  can  change  the  units  of  measurement  for  your 

document at any time by going to the File > Document 

Setup menu.

Here are some tips for setting up artboards and units of 

measurement in Illustrator:

 Use  artboards  to  organize  and  group  different 

elements of your artwork.

 Choose the correct artboard size and orientation 

for your design.

 Set the units of measurement for your document 

to ensure that your designs are the correct size 

and scale.
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 You  can  change  the  artboard  size  or  units  of 

measurement at any time.

By  following  these  tips,  you  can  create  Illustrator 

documents that  are well-organized and easy to work 

with.
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This extract presents the opening three 

sections of the first chapter.

Discover the complete 10 chapters and 

50  sections  by  purchasing  the  book, 

now available in various formats.
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This extract presents the opening three 

sections of the first chapter.

Discover the complete 10 chapters and 

50  sections  by  purchasing  the  book, 
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